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Introduction to Invisible Waves RF Analyzers

Welcome to Pro Audio White Space Finder (PAWS4400) -- a new series of PC-based RF spectrum analyzers, specifically designed for the professional audio and video industries. These new analyzers are touted as the world's first, PC-based RF spectrum analyzers which offer automatic charting of open white space (open RF frequency) for use with wireless microphones, in-ear monitors, remote control, security, access control, etc.  The unique features extend beyond the bounds of traditional RF analyzers.  Though Pro Audio White Space Finder is well suited for wireless professional audio production and AV integration, it is also the perfect tool for general commercial and industrial RF work. It supports frequency ranges 500 KHz through 4400 MHz.  Below are a few of Pro Audio White Space Finder's more unique features and functions:

· White Space & Frequency Space Finder
· Monitored Frequencies
· Region-Of-Interest (ROI) Trace View

· 3-Dimensional Waterfall History View

· Topographic Trace View

· Easy-to-use Control Panel for settings adjustments

· Highly sensitive and stable Signal Hound RF spectrum analyzer receiver

Main View
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Spectrum Trace View
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Region-Of-Interest Trace View
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Waterfall History View
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Monitored Frequencies
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White Spaces and Channel Assignments
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Topographic Map
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Control Panel
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Signal Hound is a trademark of Test Equipment Plus.

Installation

Suggested System and Hardware Requirements:

· PC running Windows XP Professional (SP3), Windows Vista, Windows 7 (32- or 64-bit)

· Microsoft .NET Framework version 3.5 (or later) 

· An available USB port for interfacing with the Signal Hound RF spectrum analyzer

· CPU: Intel Pentium 4, 1.2 GHz or faster

· Memory: 2048 MB or greater

· Hard Drive: 1000 MB free space or greater

· Video: 32 MB video RAM

· Display resolution: 1280x1024 or greater

Installing and Launching the Pro Audio White Space Finder Application

1) Before beginning the installation it will be necessary to download the latest version of Pro Audio White Space Finder from here.

2) You will need administrative privileges in order to install the application software on your computer. Please login to an account on your computer that includes 'Administrator' rights before proceeding with the installation.

3)  Run the Pro Audio White Space Finder setup program and follow the prompts for installing the application. Be sure to review the License Agreement as you progress through the installation procedure. When the Setup Wizard has completed then click the 'Finish' button.  By default the application is installed under in the folder '\Program Files\NutsAboutNets\WhiteSpaceFinder and a desktop icon is created (labeled 'White Space Finder').  
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4) Attach the Signal Hound spectrum analyzer to your PC using the USB-to-PC connection cable that shipped with the product.

5) The first time the application is launched you will be prompted to register the application.   If you have not yet purchased a Registration Code or if you do not have a Signal Hound RF spectrum analyzer then you can still run the application in 'Demo Mode'.   In 'Demo Mode' the application is fully functional but uses simulated data.  If you do have a Registration Code then you can enter it at this time by selecting 'Enter Registration Code'.  The Registration Code is 20 hexadecimal digits -- i.e. 5 groups of 4 hexadecimal digits separated by hyphens (e.g. 4254-6B62-544A-4835-3339).  When you enter the Registration Code it is not necessary to include the hyphens.
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Using the Analyzer

Diagnostic Views

Spectrum Trace View
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Pro Audio White Space Finder continuously scans and samples the signal strength (dBm) of frequencies in the range the user has specified.  In the 'Spectrum Trace' view the signal strength data (in dBm) is displayed as a function of frequency. 

By default 3 traces are displayed -- Current (green), Maxima (red) and Shadow (gray).  The Current trace displays the signal strength data from the most recent scan.  The Maxima trace displays the maximum signal strength for each frequency since the scan session was begun.  The Shadow trace displays the signal strengths of the previous scan -- often times it's interesting to note differences between the Current and Shadow scans. 
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In the upper-right-hand corner of the view there is a small rectangle that displays the current [x,y] grid coordinates in MHz and dBm.  As you move the mouse cursor around the chart then these coordinates are continuously updated.
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When you right-click the mouse button then a popup menu appears with several choices you can select from:

· Full Screen view

· Left Button used for creating Marker points or 'Hot Spots'

· Left Button used for specifying a Region-Of-Interest (ROI)

· Clear Markers and ROI outline from the display

· Hide Maxima Trace

· Hide Shadow Trace

These choices will be discussed further below...

 

Full Screen view

 

When you select 'Full Screen' from the popup menu then the Spectrum Trace view will enlarge and fill the entire screen and the two, lower display windows will become minimized.  To restore the Spectrum Trace view to its original dimensions then again access the popup menu by right-clicking the mouse and this time select 'Restore Screen'.

 

Left Button used for creating Marker points or 'Hot Spots'
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When you select 'Left Button: Marker Points' from the popup menu then subsequent left-clicks create Marker points or 'Hot Spots' that display the corresponding frequency (in MHz) and signal strength (in dBm) for the location in the grid that you just clicked on.

 

Left Button used for specifying a Region-Of-Interest (ROI)
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When you select 'Left Button: Region-Of-Interest from the popup menu then by pressing and dragging the left mouse button you can outline a Region-Of-Interest or ROI.  When Pro Audio White Space Finder first launches 3 views are displayed -- the middle one is the 'Region-Of-Interest (ROI) Trace' view.  And it is this view that will show the trace information for the ROI that you just defined.

 

Clear Markers and ROI outline from the display

 

If the 'Spectrum Trace' view becomes too cluttered with Markers and the ROI outline, then these can be removed from the display by selecting 'Clear Markers' from the popup menu.

 

   

Hide Maxima Trace / Hide Shadow Trace

 

When you select one of these options from the popup menu then the corresponding trace is no longer displayed.  If the Maxima or Shadow trace is currently hidden and you wish to display it again, then from the popup menu select 'Show Maxima Trace' or 'Show Shadow Trace' and it will once again be displayed in the view.

 

 

 

Region Of Interest Trace View
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Pro Audio White Space Finder continuously scans and samples the signal strength (dBm) of frequencies in the range the user has specified.  In the 'Region-Of-Interest (ROI) Trace' view the signal strength data (in dBm) is displayed as a function of frequency. 

By default 3 traces are displayed -- Current (green), Maxima (red) and Shadow (gray).  The Current trace displays the signal strength data from the most recent scan.  The Maxima trace displays the maximum signal strength for each frequency since the scan session was begun.  The Shadow trace displays the signal strengths of the previous scan -- often times its interesting to note differences between the Current and Shadow scans. 
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In the upper-right-hand corner of the view there is a small rectangle that displays the current [x,y] grid coordinates in MHz and dBm.  As you move the mouse cursor around the chart then these coordinates are continuously updated.
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When you right-click the mouse button then a popup menu appears with several choices you can select from:

· Left Button used for creating Marker points or 'Hot Spots'

· Clear Marker from the display

· Hide Maxima Trace

· Hide Shadow Trace

These choices will be discussed further below...

 

Left Button used for creating Marker points or 'Hot Spots'
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When you select 'Left Button: Marker Points' from the popup menu then subsequent left-clicks create Marker points or 'Hot Spots' that display the corresponding frequency (in MHz) and signal strength (in dBm) for the location in the grid that you just clicked on.

 

Clear Markers and ROI outline from the display

 

If the 'Spectrum Trace' view becomes too cluttered with Markers and the ROI outline, then these can be removed from the display by selecting 'Clear Markers' from the popup menu.

 

  

 

Hide Maxima Trace / Hide Shadow Trace

 

When you select one of these options from the popup menu then the corresponding trace is no longer displayed.  If the Maxima or Shadow trace is currently hidden and you wish to display it again, then from the popup menu select 'Show Maxima Trace' or 'Show Shadow Trace' and it will once again be included in the view.

 

 

 

 

 

Monitored Frequencies
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This feature allows you to monitor any 20 frequencies within the the frequency range supported by your receiver.  Furthermore, you can specify an 'Alert Threshold' -- such that if the signal strength falls below this threshold then the corresponding bar for that frequency turns red (otherwise it appears green).
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To specify the frequencies you wish to monitor select 'View / Monitored Frequencies' from the main menu.  The 'Monitored Frequencies' DialogBox will then appear.  From here you can enter up to 20 frequencies to monitor along with a short description.  The short description will be used to identify the frequency bar in the Monitored Frequencies view -- if a short description is not provided then the frequency (in MHz) will be used.

Adjacent to each frequency is a check box -- if a check appears in the check box then that frequency will be monitored -- otherwise, if unchecked, then it will be ignored.

This DialogBox also provides a slider control for setting the 'Alert Threshold'.  If the signal strength of a monitored frequency falls below this threshold then its corresponding bar will appear red in color (otherwise, it is green).

As a side note, the 'Monitored Frequencies' DialogBox can not be accessed while the receiver is actively scanning.  That is, if the receiver is scanning and you wish to change these frequencies then it is necessary to first press the 'Stop Scan' button.

Heatmap Timecourse
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The 'Waterfall History view is also known as a "heatmap" graph.  It is a 3-dimensional representation of the data, where the X-axis is the frequency scale, the Y-axis is a time scale, and the "Z-axis" is the color scale.  Each horizontal line in the Waterfall chart displays the signal strength (as a color) as a function of frequency as measured over the time period of one scan.  That is, with each scan (or sweep) a new row is added at the bottom of the Waterfall chart.The color legend to the right shows that stronger signals will appear red and weaker signals will appear blue. 
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On the Control Panel there is a group of settings with the heading 'Scale Settings'.  Within that group of settings there is a 'Waterfall Scale' slider control that applies only to the 'Waterfall History' view.  This control can be used to rescale the signal strengths to better spread them across the range of colors that are used.  This is useful when all the signal strengths are large and the Waterfall appears mostly red or when all the signal strengths are low and the Waterfall appears mostly blue.  For the best visual effect, ideally you'd like the peaks (strong signals) to appear red and the valleys (weak signals) to appear blue.  But sometimes even the valleys have large signal strength values or the peaks have low signal strength values.  This control is useful in remapping the color legend to better make use of the colors and how they are spread across the peaks and valleys of the signal strength values.

Whitespaces And Optimal Transmitter Locations
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This feature is used for locating open frequency space in crowded RF environments or used to assist in properly spacing transmitters for frequency coordination.  Using parameters that were set in the Control Panel a user specifies a signal strength to be used as the 'White Space Threshold', the minimum open space required for each transmitter (signal bandwidth), and the minimum spacing between adjacent transmitters (band-guard).
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The 'White Space Threshold' slider controls the threshold signal strength (in dBm) below which is considered 'White Space'.  When you adjust this control you'll also see the horizontal, white line in the Spectrum Trace view move up and down accordingly.   Along those frequency spans where the white line is solid and not interrupted by a peak, then this would be considered a White Space region.  It is completely up to the user as to what is an appropriate threshold for this control -- it depends greatly on the environment you are working in and what level of signal transmissions you feel can be safely ignored.

The results from determining the White Space regions are used for locating open frequency space in crowded RF environments and applied to computing the best frequencies and spacing for setting-up multiple transmitters -- as shown in the 'White Spaces and Optimal Channel Assignments' view.   This is most helpful when frequency coordination and RF interference are factors that need to be taken into account when selecting which frequencies or channels to use.

With regard to channel assignments, there are 3 parameters that can be set -- the signal bandwidth to allow for each transmitter, the minimum spacing between adjacent transmitters and whether or not to spread the transmitters across the entire frequency range or locate them on a "first-come-first-served" basis as White Space allows.   The application will then compute the optimal channel assignment for up to 24 transmitters (depending on the available White Space) and display these results in the 'White Spaces and Optimal Channel Assignments' view.
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When you right-click the mouse button inside the 'White Spaces and Optimal Channel Assignments' chart then a popup menu appears -- selecting 'More Info...' causes a DialogBox to appear that lists all White Spaces and Channel Assignments in table format.    Also, from this DialogBox's main menu you can select 'File / Save...' to save this information, along with an image of the corresponding chart, as an Adobe PDF file.

 

Topographic Map
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This chart shows accumulated RF energy as a function of frequency. The power of the signal strength in dBm is shown across the frequency span. A signal strength that appears with a relatively low occurrence is 'blueish' in color, whereas increasingly brighter colors are used for signal strengths that occur more frequently.  Signal strengths that occur most often are 'redish' in color. Over time, this spectral view will approximate the steady-state RF energy signature of a given environment.

Control Panel

Control Panel
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When the application first launches, the main window appears (with the various chart windows) along with the Control Panel.  The Control Panel includes important settings and is used to configure the analyzer and its operation.  

· Start / Stop Scan

· Built-in Profiles

· Scan Settings

· Sensitivity Settings

· Scale Settings

· White Space Settings

Start / Stop Scan
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Pro Audio White Space Finder employs a wide-band spectrum analyzer that scans (or sweeps across) the user-specified frequency range.  The scanning is controlled using a pair of buttons -- 'Start Scan' and 'Stop Scan'. Scanning repeats continuously from the Start to End frequencies until the 'Stop Scan' button is pressed.

 

Built-in Profiles
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The Pro Audio White Space Finder application comes pre-configured with 'Built-in Profiles'.  These profiles control many important parameters, including the following: Start and End frequencies, ROI frequency range, transmitter signal bandwidth and spacing, and the Monitored Frequencies settings.  The Pro Audio White Space Finder application also supports 'User-defined Profiles', which are discussed elsewhere.  When you select one of the built-in profiles from this drop-down list then those settings are immediately applied throughout the application and will be in effect the next time the 'Start Scan' button is pressed.  In general, the built-in profiles use default settings and differ only in their Start and End frequencies.

As a side note, the built-in profiles can not be accessed while the receiver is actively scanning.  That is, if the receiver is scanning and you wish to use a built-in profile then it is necessary to first press the 'Stop Scan' button.

 

Scan Settings
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The most important parameters are the Start and End frequencies, which are set here.  The Start and End frequencies can be set explicitly or implicitly, if you prefer, by setting the Center frequency and the Span.  They are always specified in units of megahertz (MHz).  Supported frequencies are 500 KHz through 4400 MHz.

As a side note, the scan settings can not be accessed while the receiver is actively scanning.  That is, if the receiver is scanning and you wish to change the frequency range then it is necessary to first press the 'Stop Scan' button.

 

Scaling
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The 'Vertical Scale' slider controls the height of the Y-axis in the Spectrum and ROI Trace views.  By default it is set to -30 dBm (the maximum value).  If the signal strengths are low then decreasing the 'Vertical Scale' has the effect of "zooming" the trace views.  This has no effect on the data acquisition but, rather, simply how the data is displayed.

The 'Waterfall Scale' slider control applies only to the 'Waterfall History' view.  This control can be used to rescale and remap the signal strengths to better spread them across the range of colors that are used (see legend to the right of the Waterfall History view).  This is useful when all the signal strengths are large and the Waterfall view appears mostly red or when all the signal strengths are low and the Waterfall view appears mostly blue.  For the best visual effect, ideally you'd like the peaks (strong signals) to appear red and the valleys (weak signals) to appear blue.  But sometimes even the valleys have large signal strength values or the peaks have low signal strength values.  This control is useful in remapping the color legend to better make use of the colors and how they are spread across the peaks and valleys of the signal strength values.

 

White Space Threshold
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The 'White Space Threshold' slider controls the threshold signal strength (in dBm) below which is considered 'White Space'.  When you adjust this control you'll also see the horizontal, white line in the Spectrum Trace view move up and down accordingly.   Along those frequency spans where the white line is solid and not interrupted by a peak, then this would be considered a White Space region.  It is completely up to the user as to what is an appropriate threshold for this control -- it depends greatly on the environment you are working in and what level of signal transmissions you feel can be safely ignored.

The results from determining the White Space regions are used for locating open frequency space in crowded RF environments and applied to computing the best frequencies and spacing for setting-up multiple transmitters -- as shown in the 'White Spaces and Optimal Channel Assignments' view.   This is most helpful when frequency coordination and RF interference are factors that need to be taken into consideration when selecting which frequencies or channels to use.

With regard to channel assignments, there are 3 parameters that can be set -- the signal bandwidth to allow for each transmitter, the minimum spacing between adjacent transmitters and whether or not to spread the transmitters across the entire frequency range or locate them on a "first-come-first-served" basis as White Space allows.   The application will then compute the optimal channel assignment for up to 24 transmitters (depending on the available White Space) and display those results in the 'White Spaces and Optimal Channel Assignments' view.

 

Menu Options

Creating Reports
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Pro Audio White Space Finder's has an easy-to-use report generation capability. Select File -> Create Report... from the main menu and you will be prompted for a folder and filename in which to the save a report file. An Adobe PDF-formatted file will be created that includes all charts. At the same time, Adobe Reader will be launched so you can verify the contents of the report you just created.  Also, by selecting File -> Open Report... from the main menu you can open and view Adobe PDF formatted reports you've created (or any other PDF file).

User Defined Profiles

Pro Audio White Space Finder supports two types of profiles -- pre-configured or built-in (discussed in the Control Panel section) and user-defined.  The difference is that user-defined profiles are created by you and stored as files that can later be loaded into the application.  Profiles control many important parameters, including the following: Start and End frequencies, Monitored Frequencies settings and transmitter signal bandwidth and spacing.  When you load a user-defined profile then these settings are immediately applied throughout the application and will be in effect the next time the 'Start Scan' button is pressed. 

As a side note, the user-defined profiles can not be accessed while the receiver is actively scanning.  That is, if the receiver is scanning and you wish to use apply a user-defined profile then it is necessary to first press the 'Stop Scan' button.
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To save the current settings as a new, user-defined profile then select 'File / Save As Profile' from the main menu.  A 'Save Current Settings As A Profile' DialogBox will open and you can specify a filename and location of your choice.  The default location is the 'Profiles' folder one level below the Pro Audio White Space Finder's installation directory and the default file extension is *.wsf (for White Space Finder Profile).  After specifying a filename and location you will then be asked for a short description for this profile (see below) that will appear in the Control Panel's title bar.
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When a user-defined profile is currently in use then the description that you entered (above) is used in the application's title bar (see below).  This is your visual cue as to which user-defined profile was last saved or opened.
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To open a user-defined profile that you had previously created,  select 'File / Open Profile' from the main menu.  A 'Select White Space Finder Profile' DialogBox will open and you can navigate to the folder where the profile was last saved.  Select the desired profile (as you would when opening a file in any other type of application) and press the 'Open' button.  The settings stored in the profile will then be immediately applied throughout the application and will be in effect the next time the 'Start Scan' button is pressed.  Also, the application's title bar will change to reflect the description of the newly applied profile (see above).

 

Program Options

[image: image38.wmf]
 

Selecting the 'Options' tab allows you to configure certain properties that affect how the application behaves during the current session. 

· By default, hide Maxima and Shadow traces

· Save last settings and apply them as the default settings the next time the application is launched

These choices will be discussed further below...

 

 

By default, hide Maxima and Shadow traces

 

Selecting this CheckBox causes the Maxima and Shadow traces to be hidden by default in the Spectrum and Region-Of-Interest (ROI) Trace views.  The Maxima and Shadow traces can be re-enabled from the popup menu that is accessed by right-clicking on either the Spectrum or ROI Trace view.

 

 

 

Save last settings and apply them as the default settings the next time the application is launched

 

When this CheckBox is selected then the next time the application is launched it will remember your last settings and apply them to the new session.

 

Sensitivity Settings

We recommend you leave the sensitivity settings at their default values: 0 dBm attenuation and FFT size of '1'.

Attenuation:

The internal electronic attenuator may be set to 0, 5, 10 or 15 dB.  A Local Oscillator signal may be observed at the RF input port, often found 10.7 MHz above the RF frequency being scanned. Typically, this level will not interfere with your measurements.  If you are connecting to an antenna and suspect LO feedthrough is a problem, then this can be mitigated by setting the attenuator to 15 dB. This will typically reduce your LO leakage to less than 2 nanowatts for all frequencies below 1 GHz -- but at the expense of sensitivity.

FFT Size:

By default, the resolution bandwidths (RBW) used during scanning are controlled internally.  The RBW is a function of the frequency span and the size of the FFT used to process the data.  There is an inverse relationship between RBW and FFT size -- as the FFT size increases then the RBW decreases.   It is our experience that for professional audio applications an FFT size of '1' works best -- but you are free to experiment.  Typically, as the FFT size is increased (and the RBW decreases) you'll observe the noise floor will decrease -- but this may come at the expense of sensitivity.  For example, when the RBW decreases then the amplitude of wide-band signals will also decrease.

Manufacturer's Specifications

Specifications for the Signal Hound  spectrum analyzer (taken from http://signalhound.com/spec.htm):
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Contact Us

The Pro Audio White Space Finder application software was created and copyrighted by Nuts About Nets, LLC 2011.

For PAWS4400 sales and technical support please contact Nuts About Nets at:

Nuts About Nets, LLC

2855 152nd Ave NE

Redmond WA 98052

USA

Tel: 425.881.6506

General information and sales: 
sales@NutsAboutNets.com

Technical Support: 


support@NutsAboutNets.com

Web Site: 



www.NutsAboutNets.com

1

